
Bruker BioSpin

PrepGilsonST

Preparation Gilson with SampleTrack

User Guide - Version 004

think forward 
     NMR



The information in this manual may be altered without notice.

BRUKER BIOSPIN accepts no responsibility for actions taken
as a result of use of this manual. BRUKER BIOSPIN accepts
no liability for any mistakes contained in the manual, leading to
coincidental damage, whether during installation or operation of
the instrument. Unauthorized reproduction of manual contents,
without written permission from the publishers, or translation
into another language, either in full or in part, is forbidden. 
This manual was written by

Martin Beck

© July 26, 2007: Bruker Biospin GmbH

Rheinstetten, Germany

P/N: Z31695
DWG-Nr.: 1402004



Contents

Contents ...............................................................  3

1 Introduction ........................................................... 7
1.1 Introduction ......................................................................... 7
1.2 Warnings and Notes ............................................................ 8

Note on SPE Tube Transfer and 1 mm Applications .........8
1.3 Contact for Additional Technical Assistance ......................... 8

2 Menus ..................................................................... 9
2.1 The Main Menu ................................................................... 9
2.2 File Menu Commands .......................................................... 9

Application Settings .......................................................10
Open Current Session ............................................10
Open Old Session ..................................................10
Save ... As .............................................................10

Save Current Protocol (... log) Files ...............................10
Open Print Dialog ..........................................................10
Compare Procedures Dialog Box ...................................12
Configuration Save/Load ................................................12
Exit ................................................................................13

2.3 Edit Settings Menu ............................................................ 14
For Applications with SampleTrack (Profiler, Sample-
Track) ....................................................................14
For Applications without SampleTrack (Easy, SPETT) 
...............................................................................15

2.4 Preparation Menu Commands ............................................ 16
Start Preparation Automation .........................................17

For Applications without SampleTrack (Easy, SPETT) 
...............................................................................17
For Applications with SampleTrack (Profiler and Sam-
pleTrack) ...............................................................17

Start Verify Test Loop for All Orders ...............................18
For Applications without SampleTrack (Easy, SPETT) 
...............................................................................18
For Applications with SampleTrack (Profiler and Sam-
pleTrack) ...............................................................18

Preparation Pause .........................................................18
Continue ........................................................................18
End After Current Order .................................................19
Abort Current Order .......................................................19

2.5 Service Tools Menu Commands ......................................... 19
Initialize Gilson ..............................................................20
Initialize Pump ...............................................................20
User Guide Version 004 BRUKER BIOSPIN 3 



Contents
Initialize + Home Gilson ................................................. 20
Read Barcodes .............................................................. 21
Create New Orders Dialog Box ...................................... 22

Create Orders SPE Tube Transfer ......................... 23
Load Orders and Verify .................................................. 23
Prepare Orders ............................................................. 24
Copy Orders Back From...\in\save\ ................................ 24
Modify Procedure .......................................................... 24
Delete Map: Source/Destination Matrix .......................... 24
Connect Gilson .............................................................. 25
Delete all Orders and Protocols in ST folders ................. 25
Test ............................................................................... 25

Check Positions in Tray ......................................... 25
2.6 Clean Procedures Menu Commands .................................  25

Clean Needle ................................................................ 26
Prime Dilutor ................................................................. 26
Prime Inject Port ............................................................ 26
Set ValveMate Default Solvent Position ......................... 26
Modify Clean Procedures .............................................. 26

2.7 View Menu Commands ......................................................  27
Toolbar .......................................................................... 27
Status Bar ..................................................................... 28
Modify Procedure .......................................................... 29
Configuration ................................................................. 29
Tray View ...................................................................... 29
View Main Protocol File ................................................. 30
View Current Protocol File ............................................. 31
Error History .................................................................. 31
Procedure Step View ..................................................... 32

2.8 Help Menu Commands ......................................................  33
Help Topics ................................................................... 33
Help 1MM Application .................................................... 34
About ............................................................................ 34

3 Start Selections ....................................................35
3.1 Defining Procedure Type ...................................................  35
3.2 Default Procedure Selection ..............................................  35

4 Configuration ........................................................37
4.1 Open Configuration View ...................................................  37
4.2 Base Configuration ...........................................................  39
4.3 Gilson Liquid Handler 215 Configuration ...........................  40

Default Files Configuration ............................................ 40
Execution Mode Configuration ....................................... 41

4.4 Dilutor Configuration .........................................................  42
4.5 Working Area Configuration ...............................................  43

For Applications with SampleTrack (Profiler, Sample-
Track) .................................................................... 43
For Applications without SampleTrack (Easy, SPETT) 
.............................................................................. 44
4 BRUKER BIOSPIN User Guide Version 004



Contents
Tray File Configuration ...................................................44
Adding Rack Tubes to a Zone ................................45

Remove Racks from the Tray .........................................46
Solvents in Tray Configuration .......................................47
Reagent in Tray Configuration ........................................47
Barcode Zone Configuration ..........................................48

Defining Barcode Defined Racks ............................48
Checking Barcode Rack Information .......................49

Ports in Tray Configuration ............................................50
4.6 Z-Tower Configuration ....................................................... 51
4.7 Solvent Names Configuration ............................................ 52
4.8 ValveMate Configuration .................................................... 53
4.9 Valves & Capillary Configuration ........................................ 54
4.10 Gilson Cover & LED Configuration ..................................... 55

5 The Rack Editor ................................................... 57
5.1 Opening the Rack Editor .................................................... 57
5.2 Rack Selection .................................................................. 58

Carrier Selection ............................................................59
5.3 Creating a New Rack ......................................................... 60

Deleting a Rack .............................................................61
5.4 Bruker or Custom Racks .................................................... 62

Bruker Racks: ........................................................62
Custom Racks: ......................................................62

5.5 Modifying Racks ................................................................ 62
5.6 Service Tools ..................................................................... 64

6 Preparation Data Files ......................................... 65
6.1 Data Directory Structures ................................................... 65

Main Folder ...................................................................65
Configuration Files Directory ..........................................65
Preparation Procedure Files Directory ............................66
Temporary Settings Files ................................................66
Temporary Protocol Files ...............................................66

6.2 Viewing Preparation Procedure Data Files ......................... 67
6.3 Protocol Files .................................................................... 67

7 Order Files ........................................................... 69
7.1 Directory Structure of Order Files ...................................... 69

Main Directory ...............................................................69
Input Order Files Directory .............................................70
Output Order Files Directory ..........................................70
Order Protocol Files Directory ........................................70

7.2 Viewing Order Files ........................................................... 71

8 Solvents ............................................................... 73
8.1 Defining Solvents for Preparation ...................................... 73
8.2 Defining External NMR Solvents ........................................ 73
User Guide Version 004 BRUKER BIOSPIN 5 



Contents
9 Edit Procedures ....................................................75
9.1 Modifying TASK Procedures ..............................................  75
9.2 TASK Procedures ..............................................................  75

Common TASK dialog box Elements .............................. 75
9.3 Types of TASK Procedures ................................................  76

Task Procedure Wash .................................................... 76
Task Procedure Clean ................................................... 77

Automatic Cleaning ............................................... 77
Task Procedure Add ...................................................... 78
Task Procedure Dispense .............................................. 79
Task Procedure Mix ....................................................... 80
Task Procedure 1MM Samples ...................................... 80

9.4 Modifying the Procedure Dialog Box ..................................  81

10 Test/Service Tips ..................................................83
10.1 Service Information ...........................................................  83

A How To... .............................................................. 85
A.1 Introduction .......................................................................  85
A.2 Define Application Type .....................................................  85
A.3 Create Orders ...................................................................  85
A.4 Modify Task Procedures ....................................................  86
A.5 Insert Racks ......................................................................  87

Inserting a New Rack .................................................... 87
A.6 Insert Racks with Barcode Simulation ................................  88
A.7 Adding Zones and Tubes to a Zone ...................................  90

Adding a Zone Manually ................................................ 91
Adding Tubes to a Zone Manually .................................. 92
Removing Tubes from a Zone Manually ......................... 92
Adding Zones and Tubes Automatically ......................... 92

A.8 Define Sort Orders ............................................................  93

Figures ................................................................. 95

Tables .................................................................. 97
6 BRUKER BIOSPIN User Guide Version 004



1Introduction 1 

Introduction 1.1

Preparation Gilson + SampleTrack (PrepGilsonST) is a sample preparation pro-
gram which controls a Gilson "215" or "235" instrument with additional "8xx"
valves and "ValveMate".

Predefined preparation step procedures can be modified by the user and will be
executed.

Depending on the application type, a barcode reader identification can be used
and orders can be defined by the "SampleTrack" program.

The type of destination racks can be specified and used to define destination po-
sitions automatically.

When SampleTrack is not used, the user can create orders when defining source
samples, procedures, and push solvents.

Note: Throughout this manual Preparation Gilson + SampleTrack will simply be
referred to as PrepGilsonST.
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Introduction
Warnings and Notes 1.2

There are two types of information notices used in this manual. These notices
highlight important information or warn the user of a potentially dangerous
situation. The following notices will have the same level of importance throughout
this manual.

Note: Indicates important information or helpful hints

WARNING: Indicates the possibility of severe personal injury, loss of life or
equipment damage if the instructions are not followed.

Note on SPE Tube Transfer and 1 mm Applications 1.2.1

For information on the “SPE-TT System” refer to the manual SPE-TT system In-
stallation and Users Manual for Solid Phase Extraction Tube Transfer Systems
available from Bruker.

For additional help on 1 mm applications, refer to the online help included with the
PrepGilsonST program.

Contact for Additional Technical Assistance 1.3

For further technical assistance on the PrepGilsonST, please do not hesitate to
contact your nearest BRUKER dealer or contact us directly at:

BRUKER BioSpin GMBH
am Silberstreifen
D-76287 Rheinstetten
Germany

Phone: + 49 721 5161 0
FAX: + 49 721 5171 01
E-mail: martin-beck@bruker-biospin.de
Internet: www.bruker.de
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2Menus 2 

The Main Menu 2.1

The main menu consists of:

"File Menu Commands" 

"Edit Settings Menu"

"Preparation Menu Commands"

"Service Tools Menu Commands"

"Clean Procedures Menu Commands"

"View Menu Commands"

"Help Menu Commands"

File Menu Commands 2.2

The File menu offers the following commands: 

Table 2.1. The File Menu Commands

Application Settings Open Current Session Opens the current session file 
curr_session.pgi.

Open Old Session Opens an old session file *.pgi

Save...As Saves the current session file under a dif-
ferent file name.

Save Current Protocol (...log) Files Saves the current protocol files.

Open Print Dialog Opens the print dialog box allowing selec-
tion of print options for the current order 
protocol.

Compare Procedures Dialog Opens a dialog box allowing the compari-
sion of procedures.

Configuration save/load Used to backup and reload coniguration 
files *.cfg and *.735.

Exit Exits the PrepGilsonST program.
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Menus
Application Settings 2.2.1

Open Current Session
Use this command to reload the current session (settings) file (curr_session.pgi)
after checking an old session file. 

The current session file is loaded automatically when the program is opened and
the application type is selected (see "Default Procedure Selection" on page
35).

The name of the current session file is visible in the caption of the main window.
The content of the current session file can be viewed in the Edit Settings dialog
box (see "Edit Settings Menu").

Shortcut Keys: CTRL+O

Open Old Session
Use this command to open an old session file (*.pgi) in the PrepGilsonST pro-
gram.

This is used only to view the old session file contents in the "Edit Settings
Menu". Several menus will be disabled and the contents cannot be changed and
saved. After opening an old session the program should be closed and reopened
for automatic preparation.

The name of the current session file of the selected application will remain visible
in the caption of the main window.

Save ... As
Use this command to save the active session as a file with another name (only
used for checking the settings at later time!).

PrepGilsonST displays the Save As dialog box so you can name the file.

Save Current Protocol (... log) Files 2.2.2

Saves the current protocol files. During this procedure a copy of the current proto-
col files are produced as follows:

log_current.log saved to ...\G215Data\Exec\saved_log_current.log

log_exec.log saved to ...\G215Data\Exec\saved_log_exec.log

A copy of the session file is also made:

curr_session.pgi saved to ...\G215Data\Exec\saved_curr_session.pgi

Open Print Dialog 2.2.3

Selecting this menu option will open the Print Order List dialog box where all in-
formation for the automatically generated print list can be selected:
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File Menu Commands
Figure 2.1. Print Order List Dialog Box

For each header combination of procedure files and solvents, one separate list
will be generated. For example for the order list... 

...the following print list will be generated, saved in the PrintOrderList.txt file and
then be displayed in the Notepad program.
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Menus
The Print List will be saved in the default print file:

[Order Folder]\bstsdata\gilson\out\protocol\PrintOrderList.txt (when running
with SampleTrack)

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\PrintOrderList.txt (when
running without SampleTrack)

Compare Procedures Dialog Box 2.2.4

With the Checkbox “Compare folders“ disabled, two single procedures can be
compared.

With the Checkbox “Compare folders“ enabled, all procedures of the selected
folder can be compared.

Figure 2.2. Compare Step Procedures Dialog Box

When comparing all procedures in two folders the color in the Procedure List
shows the procedure status:

• Green: No differences between the procedure in first and second folder.

• Blue: Differences detected between the procedure in first and second folder.

• Red: The procedure in the first folder does not exist in the second folder.

In the two procedure text boxes for the first (left) and the second folder (right) dif-
ferent lines of the selected procedure are displayed “blue“ (in the column “NR“),
e.g. line 3 and 5 in the example.

Configuration Save/Load 2.2.5

Backups and reloads the configuration files *.cfg and *.735 of the current applica-
tion in the working folder [Install Folder Data]\G215Data\Config\.
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File Menu Commands
Figure 2.3. The Load/Save Configuration Dialog Box

Default config files for each Application are written at Installation time into the In-
stall folder: [Install Folder Data]\G215Data\Config\Restore\

When starting an Application the program is checking if config files are existing in
the working folder: [Install Folder Data]\G215Data\Config\

If there are no files found, a copy of the default files from the Install folder
...\Restore\ will be moved automatically into the working folder.

Note: For applications with SampleTrack (Profiler, SampleTrack) the tray configu-
ration is grayed (only automatically changeable using the barcode reader). 

Exit 2.2.6

Exits the PrepGilsonST session. You can also use the Close command on the ap-
plication control menu. The program will prompt you to save documents with any
unsaved changes if applicable.
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Menus
Shortcuts: Double-click the applications control menu button, or click on the close
button, or prest ALT + F4.

Edit Settings Menu 2.3

For Applications with SampleTrack (Profiler, SampleTrack)
The Edit Settings menu opens the Edit Settings dialog box from SampleTrack
where the following preparation modes can be defined:

• Web service server URL.

• Procedure export folder.

• SampleTrack order folder.

Figure 2.4. The Edit Settings Using Web Service Dialog Box

Reset to default settings values and save:

Restores all setting values to the default values delivered with the installa-
tion in the file „...\G215Data\Exec\Restore\default_session_xxxx.pgi“  (
“xxxx” depends on the selected application type).
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Edit Settings Menu
For Applications without SampleTrack (Easy, SPETT)
The Edit Settings menu opens the Edit Settings dialog box where the following
preparation modes can be defined.

Figure 2.5. The Edit Settings Dialog Box 

Table 2.2. Description of the Edit Settings Fields

Folders for Procedures 
and Orders

Order Folders Orders and protocols are stored in the path of the 
edit box Order Folders + \in_no_ST\

Mode of Used Destina-
tion Tubes

Using Destination 
Matrix

If checked, the field Destination Matrix Type is 
used to find an empty destination matrix of this 
type for orders loaded in the currently inserted 
source racks.
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Menus
Preparation Menu Commands 2.4

The Preparation menu offers the following commands: 

Manually Destination 
Selection

If checked source tubes and destination tubes can 
be defined in the Create Orders dialog box (see 
"Create Orders" on page 85).

If this is not checked only source tubes can be 
defined in the Create Orders dialog box and desti-
nation racks shown in the Automatically used 
Destination Matrix Type field will be used auto-
matically.

Preparation Mode Verify Each Proce-
dure Only One Time

Procedures with the same name will be checked 
only one time before execution.

Automatic Clean Proce-
dure

The Clean Procedure name is defined in the 
"Configuration" section (see also "Clean Proce-
dures Menu Commands").

Select the appropriate options to run this proce-
dure before the beginning of the order procedure 
loop OR/AND after the last order.

Sort Orders mode Sort Orders Inside 
Rack By

Orders can be sorted inside racks by Creation 
time (default), Position, or Solvent.

Reset Default Values The reset default values button restores all setting 
values to the default values delivered with the 
installation in the file:

„...\G215Data\Exec\Restore\default_session_xx
xx.pgi 

(„xxxx“ depends on the selected application type).

Table 2.3. The Preparation Menu Commands

Start Preparation Automation Start Automation = Init + Read Barcodes + Read 
Orders + Verify + Preparation

Start Verify Test All Orders 
Test Loop

Starts the verify test loop for Profiler applications.

Table 2.2. Description of the Edit Settings Fields
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Preparation Menu Commands
Start Preparation Automation 2.4.1

For Applications without SampleTrack (Easy, SPETT)
When the automation is started using one of the shortcuts listed below, a new
preparation loop for all available orders will be started:

• Initialize Gilson

• Read Barcodes if the barcode reader is selected in the configuration.

• Deletes all old orders.

• Load orders 

• Verify orders

• Run default Clean procedure if selected in the settings dialog box.

• Run Preparation procedures loop (for all available orders).

• Run default Clean procedure if selected in the settings dialog box.

For Applications with SampleTrack (Profiler and SampleTrack)
A new preparation loop will be started:

• One order will be loaded via the web service server, verified and executed be-
fore the next order will be requested.

• All urgent order will be delivered from the SampleTrack web service server
first.

Select the menu "Preparation Pause" or the Toolbar  to stop the prepara-
tion.

Select the menu "End After Current Order" or the Toolbar  to stop after
current order and to finish the order loop.

Select the menu "Abort Current Order" or the Toolbar  to abort the prepa-
ration immediately.

Shortcuts: Toolbar:   or Keys: CTRL+A

Pause after current movement Stops after the current movement and waits. Select 
the menu Continue to continue the preparation.

Continue Continues the preparation after Pause.

End after current order Stops after the current order and finish order loop.

Abort current order Aborts the current order and finish order loop.

Table 2.3. The Preparation Menu Commands
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Menus
Start Verify Test Loop for All Orders 2.4.2

If the user wants to check all available orders when starting the program this
menu could be used.

For Applications without SampleTrack (Easy, SPETT)
A new verification test loop for all orders will be started: 

• Initialize Gilson.

• Read Barcodes if the barcode reader is selected in the configuration.

• Deletes all old orders.

• Create orders in the Create New Orders dialog box.

• Load orders.

• Verify orders.

For Applications with SampleTrack (Profiler and SampleTrack)
A new verification test loop for all orders will be started: 

• A test loop will be started.

• All available orders will be loaded from the Web Services server.

• All available orders will be verifyed.

• All available orders will be removed from the order list and the status will be re-
setted via Web Services.

When the Test is running, the text “Test Verify All Orders“ will be displayed:

Preparation Pause 2.4.3

Preparation pause: Stops after current movement and waits for the menu "Con-
tinue". Select the menu "Continue" or the Toolbar  button to continue the
preparation.

Continue 2.4.4

Select this menu to continue the preparation after Pause.

Shortcuts: Toolbar  
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Service Tools Menu Commands
End After Current Order 2.4.5

Stops after the currently running order and finishes the order loop.

Shortcuts: Toolbar 

Abort Current Order 2.4.6

The currently running order will be stopped immediately with an error status and if
the order loop was running it will be stopped. A Home Seek will be performed au-
tomatically.

Shortcuts: Toolbar 

Service Tools Menu Commands 2.5

The Service Tools menu offers the following commands: 

Table 2.4. The Preparation Menu Commands

Initialize Gilson Intializes the Gilson instrument.

Initialize Pump Initializes the Gilson instrument and the dilutor pump.

Initialize + Home Initializes the Gilson instrument and performs a home 
seek.

Read Barcodes Runs the Read Barcodes task.

Create New Orders Dialog Creates new orders dialog box.

Load New Orders and Verify Loads orders from order directory and verifies orders.

Prepare all Orders Prepares the orders.

Modify Procedure Shows or hides a Procedure View in the main window in 
order to modify task procedures at a high edit level for 
customers.

Connect Gilson Connects the Gilson after changing the configuration.

Delete Map: Source-Destination 
Matrix

Delete Map: Source destination matrix

Change Syringe For service personnel only! Used to change the syringe.

Delete all Orders and Protocols 
in ST Folders

Reloads the configuration file.

Test: Check Positions in Tray Special dialog box used to check all XYZ positions in the 
tray (racks, ports, etc.).
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Menus
Initialize Gilson 2.5.1

Note: Menu enabled only for applications without SampleTrack (Easy,
SPETT).

Runs the Initialize Gilson task:

1. Write procedure List file of all useable procedures in SampleTrack.

2. Write solvent List file of all defined solvents for SampleTrack.

3. Start to write a new Current protocol file.

4. Reset Errors.

5. Set Gilson Z Tower clamp height variable.

6. Set Gilson liquid level detection threshold variable.

7. Initialize barcode reader (if installed).

8. Checking Z axis.

9. Checking XY axis.

10. Checking Dilutor pump (not homing!) 

Initialize Pump 2.5.2

Runs the Initialize Pump task: 

1. Writes a procedure list file of all usable procedures in SampleTrack.

2. Writes a solvent list file of all defined solvents for SampleTrack.

3. Starts to write a new current protocol file.

4. Resets errors.

5. Sets the Gilson Z-tower clamp height variable.

6. Sets the Gilson liquid level detection threshold variable.

7. Initializes the barcode reader (if installed).

8. Checks the Z-axis.

9. Checks the XY-axis.

10. Checks the dilutor pump at the rinse station.

Initialize + Home Gilson 2.5.3

Note: Menu enabled only for applications without SampleTrack (Easy, SPETT).

Runs the Initialize + Home Gilson task. 

1. Write procedure list file of all useable procedures for order creation.

2. Write solvent list file of all defined solvents for order creation.

3. Start to write a new current protocol file.

4. Reset Errors.
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Service Tools Menu Commands
5. Set Gilson Z-tower clamp height variable.

6. Set Gilson liquid level detection threshold variable.

7. Initialize barcode reader (if installed).

8. Homing Z axis.

9. Homing XY axis.

10. Homing dilutor pump at rinse station.

Read Barcodes 2.5.4

Note: Menu enabled only for applications without SampleTrack (Easy,
SPETT).

• Called automatically when starting automation loop with the start toolbar but-
ton.

Runs the Read Barcodes task.

1. Reads both ID and TYPE barcodes at all defined barcode racks (displayed
with red frames in the barcode view of the tray configuration).

2. Deletes old barcode defined racks in the tray configuration if they are removed
from the Gilson.

3. Creates new barcode defined racks and zones (with the name of the Rack ID
barcode) in the tray configuration if the barcodes are found.

All sites in the tray can be defined as barcode defined sites: See also "Barcode
Zone Configuration" on page 48.
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Menus
Figure 2.6. Working Area Configuration: Barcode Zones 

Create New Orders Dialog Box 2.5.5

Note: Menu enabled only for applications without SampleTrack (Easy,
SPETT).

• Called automatically when starting the automation loop with the start toolbar
button.

Orders can be created in this dialog box without SampleTrack.
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Service Tools Menu Commands
Figure 2.7. The Create Order Files Dialog Box

When checking File name with ’_ID’ an additional number will be added to the
order name, so multiple orders for the same source position are possible. 

Create Orders SPE Tube Transfer
The solvent selection is grayed. The Delete Created Orders is enabled.

Load Orders and Verify 2.5.6

Note: Menu enabled only for applications without SampleTrack (Easy,
SPETT).

Runs the Load Orders and Verify task (without Automation after Initialize and
Read Barcodes).

• Called automatically when starting automation loop with the start toolbar but-
ton.
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Menus
For applications with SampleTrack (Profiler, SampleTrack):

• Only called automatically when starting automation loop with the start toolbar
button.

• One order will be loaded via WEB SERVICE  Server, verified and executed be-
fore the next order will be requested.

• All Urgent orders will be delivered from the SampleTrack Web Service  Server
first.

Prepare Orders 2.5.7

Note: Menu enabled only for applications without SampleTrack (Easy,
SPETT).

Runs the procedures preparation loop (for all available orders without Automa-
tion after Initialize, Read Barcodes, and Load Orders and Verify).

Called automatically when starting automation loop with the start toolbar button.

Copy Orders Back From...\in\save\ 2.5.8

Copies orders from the directory ..\in\save into the directory ... \in\

Used for tests or if racks with the same Barcode ID and the same samples are
used again.

Not used for „1 mm Sample preparation“ or „SPE Tube Transfer“ applications.

Modify Procedure 2.5.9

See "Edit Procedures" on page 75.

Delete Map: Source/Destination Matrix 2.5.10

Deletes all relations between the source Matrix ID Racks and Destination Matrix
ID Racks.

Not used for 1mm Sample Preparation or for SPE tube transfer applications!

Only relevant with option „Preparation Mode: Using Destination Matrix” in the
"Edit Settings Menu" dialog box!

After reading the Rack ID barcodes during the „Loading and Verifying Orders” pro-
cedure, all orders will be checked if they need a new Destination Rack of the Des-
tination Rack Type, as defined in the field „Destination Matrix Type” of the "Edit
Settings Menu" dialog box.

If there is no Destination Rack defined for the current Source Rack in the Source/
Destination Map, and an empty Destination Rack is found in the tray, then the cur-
rent Source Rack of the Order and the empty Destination Rack will be written as
“connected” into the Source/Destination Map. 
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Clean Procedures Menu Commands
The Source/Destination Map will then be saved.

After restarting the program, or for new Source Rack orders in the Source/Desti-
nation Map, the Destination Rack will be the same.

If a Barcode ID is used more than one time (not recommended!):

• The customer must clear the Destination Rack and fill the Source Rack.

• If only the Source or the Destination ID has changed, this menu has to be used
to delete all relations between Source Matrix ID Racks and Destination Matrix
ID Racks.

Connect Gilson 2.5.11

NOTE: Not for BEST or Profiler applications!

This menu could be used to connect the Gilson liquid handler , if the Gilson is dis-
connected after an Error when starting this program. 

Typically the Gilson will be connected automatically when starting this program. If
another configuration is used when starting the program with different values in
the Gilson “non volatile memory” (e.g. Z-tower clamp height or syringe size) the
Gilson reports an error and will be disconnected. In this case the user could close
this program and restart again or use this command for correct connection to the
Gilson.

Delete all Orders and Protocols in ST folders 2.5.12

Typically all executed orders and protocols will be saved in the appropriate file
folders. This menu can be used to delete all orders and protocols in the appropri-
ate file folders. The folder names are different depending on whether the current
application is using SampleTrack or not (see "Directory Structure of Order
Files" on page 69).

Test 2.5.13

Check Positions in Tray
Special dialog box used to check all XYZ positions in the tray (racks, ports, etc.).

Clean Procedures Menu Commands 2.6

The Clean Procedures menu offers the following commands, which enable you
to arrange multiple views of multiple documents in the application window: 

Table 2.5. The Clean Procedures Menu Commands

Clean Needle The clean needle menu command starts the clean needle proce-
dure.

Prime Dilutor - Purge System Runs the Prime Dilutor procedure.
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Menus
The procedures Clean Needle, Prime Dilutor and Prime Inject Port are defined
in the default file configuration.

When the Default File Configuration is called from the clean procedures menu,
the Gilson Liquid Handler 215 configuration is displayed in the configuration view.

Clean Needle 2.6.1

The clean needle menu command starts the clean needle procedure. The proce-
dure is defined in the Gilson Liquid Handler 215 section of the configuration.

Prime Dilutor 2.6.2

Runs the Prime Dilutor procedure. 

The procedure is defined in the Gilson Liquid Handler 215 section of the configu-
ration.

Prime Inject Port 2.6.3

Runs the Prime Inject Port procedure. 

The procedure name is defined in the Gilson Liquid Handler 215 section of the
configuration.

Set ValveMate Default Solvent Position 2.6.4

Moves ValveMate to the default solvent position (defined in "Dilutor Configura-
tion" on page 42).

Modify Clean Procedures 2.6.5

Opens the Clean TASK procedure edit dialog box (see "Task Procedure Clean"
on page 77).

Prime Inject Port Runs the Prime Inject Port procedure.

Set ValveMate default solvent 
position

Moves ValveMate to the default solvent position (defined in the Dilu-
tor configuration).

Modify Clean Procedure Opens the Clean TASK procedure edit dialog box.

Table 2.5. The Clean Procedures Menu Commands
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View Menu Commands
View Menu Commands 2.7

The View menu offers the following commands: 

Toolbar 2.7.1

Use this command to display and hide the Toolbar, which includes buttons for
some of the most common commands in PrepGilsonST, such as File Open. A
check mark appears next to the menu item when the Toolbar is displayed.

The Toolbar

The Toolbar is displayed across the top of the application window, below the menu
bar. The Toolbar provides quick mouse access to many tools used in
PrepGilsonST.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Table 2.6. The View Menu Commands

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Barcode List Shows or hides the barcode list of connected source and desti-
nation barcode racks.

Modify Procedure Shows or hides a Procedure View in the main window to modify 
Task procedures at a high edit level for customers.

Configuration Shows or hides the configuration dialog box.

Tray Shows or hides the tray dialog box.

Main Protocol File Shows or hides the main protocol in the protocol dialog box.

Current Protocol File Shows or hides the current protocol in the protocol dialog box.

Procedure Steps Shows or hides the current master step procedure dialog box.

Solvent Consumption 
Information

For applications without SampleTrack only. This command is 
used to show a message box with the required solvent amounts 
for all orders after the verification.

Error History Shows the error history dialog box with all the errors which have 
occurred after starting the program. In each line of the list one 
error will be displayed. When clicking on an error line all details 
of the error will be displayed in the information field.

Table 2.7. Menus with Toolbar Buttons

Start Preparation Automation Start Automation = Init + Read Barcodes + Read Orders + 
Verify + Preparation.

Pause after current movement Preparation Pause: Stop after current movement and wait.
Select the Menu Continue to continue the preparation.
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Menus
Status Bar 2.7.2

Use this command to display or hide the Status Bar, which describes the action to
be executed by the selected menu item or depressed Toolbar button, and the key-
board latch state. A checkmark appears next to the menu item when the status
bar is displayed.

The status bar is displayed at the bottom of the PrepGilsonST window. To display
or hide the status bar, use the Status Bar command in the View menu.

Figure 2.8. The Status Bar 

The left area of the status bar describes actions of menu items as you use the ar-
row keys to navigate through menus. This area similarly shows messages that de-

Continue Continue the preparation after a pause.

End After Current Order End after current order and finish order loop. 

Abort Current Order Abort current order and finish order loop.

Move Arm to Other Side Moves the Gilson arm into a different position if the barcode 
reader did not allow the rack exchange.

Configuration Shows or hides the Configuration View to see configuration 
details or to perform modifications if the instrument is not 
running. 

Modify Procedure Shows or hides a Procedure View in the main window to 
modify task procedures at a high edit level for customers. 

Start Verify Test All Orders Starts the verify test loop.

Barcode List Shows or hides the barcode list of connected source and 
destination barcode racks.

Tray View Shows or hides the tray dialog box.

View Main Log File Shows or hides the main protocol in the protocol dialog box.

Log File Shows or hides the current protocol in the protocol dialog 
box view.

Procedure Steps Shows or hides the current master step procedure dialog 
box.

Table 2.7. Menus with Toolbar Buttons
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View Menu Commands
scribe the actions of Toolbar buttons as you depress them, before releasing them.
If after viewing the description of the Toolbar button command you wish not to ex-
ecute the command, then release the mouse button while the pointer is off the
Toolbar button.

The right areas of the status bar indicate which of the following keys are latched
down:

Indicator Description

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.

Modify Procedure 2.7.3

Shows or hides a Procedure View in the main window, which is used to modify
Task procedures at a high edit level for customers.

See "Modifying the Procedure Dialog Box" on page 81.

Configuration 2.7.4

Shows or hides the configuration view in order to see configuration details or to
perform modifications if the instrument is not running (see "Open Configuration
View" on page 37).

Shortcuts: Toolbar 

Tray View 2.7.5

Shows or hides the tray dialog box. By moving the cursor over Containers (dark
gray), Racks (light gray) or Tubes (colors defined) different information for the ob-
ject under the cursor will be displayed in a yellow pop-up window:
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Menus
Figure 2.9. The Tray View Dialog Box 

Different view modes can be selected by checking the „Status“ or „Barcode“ check
boxes in the View Mode block.

• When Status is checked the status information for each tube will be shown.

• When Barcode is checked the barcode defined racks will be highlighted within
a red frame.

Shortcuts: Toolbar 

View Main Protocol File 2.7.6

Shows or hides the main protocol file with all the important information after the
program is started.
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View Menu Commands
Figure 2.10. Main Protocol File 

This view can also be used to display other informaiton:

1. Input order files from SampleTrack.

2. Output result order files to SampleTrack.

View Current Protocol File 2.7.7

Shows or hides the cuurent protocol file with all the important information from the
selected/current order.

This view can also be used to display other information:

1. Input order files from SampleTrack.

2. Output result order files to SampleTrack.

Shortcuts: Toolbar 

Error History 2.7.8

This command is used to show a dialog box with all errors after starting the pro-
gram:
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Menus
Figure 2.11. The Error History View

In each line of the list one error will be displayed (old errors on the top of the list
based on the time stamp).

When clicking on one error line all details of the error will be displayed in the infor-
mation fields.

Procedure Step View 2.7.9

Shows the Procedure Step View:

• Move the mouse cursor over one step, or click on the step icon to see details
of one step!

• Shows the currently loaded or running main procedure in the upper part of the
window.

• If there is a sub-procedure running, it is shown in the lower part of the window.
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Help Menu Commands
Figure 2.12. Procedure Step View 

Note:

• It is not possible to display the procedure as a text file, but only as a protocol
text file after execution.

• For service personal only: Procedures that are not running can be displayed
in the Procedure Editor program.

Shortcuts: Toolbar 

Help Menu Commands 2.8

The Help Menu offers various options which provide assistance with this applica-
tion: 

Help Topics 2.8.1

Use this command to display the opening help window. From this window, you can
jump to step-by-step instructions on using PrepGilsonST and various other types
of reference information. 

Once you open the help window you can click the Contents button whenever you
want to return to the opening screen.

Table 2.8. The Preparation Menu Commands

Help Topics Offers you an index of topics on which you can get help.

Help 1MM Application Open the help file for 1 mm applications.

About Displays the version number of this application
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Menus
Help 1MM Application 2.8.2

Use this command to display the online help file for 1MM applications.

About 2.8.3

Use this command to display the copyright notice and version number of your
copy of PrepGilsonST.
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3Start Selections 3 

Defining Procedure Type 3.1

When starting the program the first time after installation the "Default Procedure
Selection" dialog box appears enabling you to define the type of procedure and
configuration settings in the registry.

Five types of procedures can be selected:

• Easy Preparation

• 1mm Sample Preparation

• SPE Tube Transfer

• Profiler Preparation

• SampleTrack Preparation

After performing an initialization using the menu “Service tools” -> "Initialize
Pump", all procedures in the Export directory (defined in the "Edit Settings
Menu" dialog box) will be exported to enable a selection of these procedures in
the selection box of SampleTrack or in the BEST program.

Default Procedure Selection 3.2

When starting this program after installation, the following box appears which al-
lows you to define the application type (to perform different settings in the Regis-
try), or to modify the path inside all the procedures: 

Figure 3.1. The Select Default Procedure and Configuration dialog box 
User Guide Version 004 BRUKER BIOSPIN 35 (99)



Start Selections
The following files will be set in the registry (in HKEY_LOCAL_MACHINE->SOFT-
WARE->Bruker BioSpin->): 

The following „Current session” default files will be copied into the file 
\exec\curr_session.pgi:

1. Easy Preparation: default_session_Easy.pgi

2. 1mm Sample preparation: default_session_1mm.pgi

3. SPE Tube Transfer: default_session_SPETT.pgi

4. Profiler Preparation: default_session_Profiler.pgi

5. SampleTrack Preparation: default_session_SampleTrack.pgi

If it is desired that this box does not appear the next time the program is started,
please select:

• The check box „Do not show this dialog box again!” in this dialog box, or, 

• The check box „Do not show the Default Selection dialog box when start-
ing the program!” in the "Edit Settings Menu" dialog box.

1. Easy Preparation: ->Gilson Control->ApplicType=7

->Gilson Control->GExecCtrl->Config file= \Config\default_Easy.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\Easy\default_Easy.gsp

2. 1mm Sample Preparation: ->Gilson Control->ApplicType= 2

->Gilson Control->GExecCtrl->Config file= \Config\default_1mm.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\1mm\default_1mm.gsp

3. SPE Tube Transfer: ->Gilson Control->ApplicType= 5

->Gilson Control->GExecCtrl->Config file= \Config\default_SPETT.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\SPETT\default_SPETT.gsp

4. Profiler Preparation: ->Gilson Control->ApplicType= 6

->Gilson Control->GExecCtrl->Config file= \Config\default_Profiler.cfg

->Gilson Control->EditProcedure->Procedure= \Proc\Profiler\default_Profiler.gsp

5. SampleTrack preparation: ->Gilson Control->ApplicType= 8

->Gilson Control->GExecCtrl->Config file= \Config\default_SampleTrack.cfg\

->Gilson Control->EditProcedure->Procedure= \Proc\SampleTrack\default_SampleTrack.gsp\
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4Configuration 4 

Open Configuration View 4.1

To open the configuration view, start the program: 

Then press the Configuration View button from the toolbar.

Figure 4.1. The Configuration View dialog box 

Each of the different configuration sections are displayed inside a blue frame.
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Configuration
By moving the mouse cursor around inside the blue frames, various configuration
tool tips will be displayed:

By clicking inside the blue frames (here shown as yellow areas) special dialog boxes will open shown 
various configurations.

"Base Configuration" Defines the installed components of the 
configuration.

"Gilson Liquid Handler 
215 Configuration"

Defines default files and Gilson instru-
ment type specific configuration.

"Dilutor Configuration" Defines the usable solvent list, the dilu-
tor syringes and the default solvent.

"Working Area Configu-
ration"

Defines the working area:
- "Tray File Configuration"
- "Solvents in Tray Configuration"
- "Reagent in Tray Configuration"
- "Barcode Zone Configuration"

"Z-Tower Configura-
tion"

Defines the needle adjustment.

"Solvent Names Config-
uration"

Defines the solvent names.
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Base Configuration
Base Configuration 4.2

In the base configuration dialog box the following items can be defined:

• The liquid handler type, either ’215’ or ’235’.

• The basic GSIOC ID.

• The serial ports (RS232) used (for the Gilson, barcode reader, and SPE tube
transfer).

• Other additional installation options used.

"ValveMate Configura-
tion"

Defines the Valvemate solvents.

"Valves & Capillary 
Configuration"

Defines the valves and capillary config-
uration.

"Gilson Cover & LED 
Configuration"

Defines the reaction after opening the 
cover.
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Configuration
Figure 4.2. The Base Configuration dialog box

Gilson Liquid Handler 215 Configuration 4.3

The Gilson Liquid Handler 215 configuration defines default files and the Gilson
execution mode configuration.

Default Files Configuration 4.3.1

In the Default Files configuration, the following Gilson liquid handler 215 files can
be configured:

• A default path for all procedures can be defined (application specific).

• When clicking on a line in the list, a default file for the selected type can be de-
fined in a dialog box.
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Gilson Liquid Handler 215 Configuration
Figure 4.3. The Gilson Default Files Configuration Dialog Box

Execution Mode Configuration 4.3.2

In the Execution Mode configuration, the following Gilson liquid handler 215 infor-
mation can be configured:

• When the program is running, protocol files can be written.

• Different wash procedures can be defined for various ValveMate solvent
changes.

• The Solvent Configuration button can be used to define solvent names in the
"Dilutor Configuration".

• The Edit Solvent Positions at ValveMate button can be used to define sol-
vent positions in the "ValveMate Configuration".
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Configuration
Figure 4.4. Gilson 215 Execution Mode Configuration 

Dilutor Configuration 4.4

The Dilutor Configuration dialog box can be used to define:

• The dilutor type (currently only “Type 402“ is supported):

• The number of syringes that can be used (currently only one syringe is sup-
ported);

• The size and the maximum speed of the syringe;

• A reduced maximum speed of the syringe.
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Working Area Configuration
Figure 4.5. The Dilutor Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the
"Solvent Names Configuration" dialog box and provides a link to define solvent
positions in the ("Tray File Configuration") dialog box.

Working Area Configuration 4.5

The Working Area Configuration allows configuration of the working area. The
areas that can be configured depend on the applications that will be used. The
working area for applications using SampleTrack are slightly different then those
used without SampleTrack.

For Applications with SampleTrack (Profiler, SampleTrack)
Four configuration dialog boxess are available for applications with SampleTrack:

• "Tray File Configuration"

• "Solvents in Tray Configuration"

• "Reagent in Tray Configuration"

• "Ports in Tray Configuration"
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For Applications without SampleTrack (Easy, SPETT)
Four configuration dialog boxes are available for applications without Sample-
Track:

• "Tray File Configuration"

• "Solvents in Tray Configuration"

• "Reagent in Tray Configuration"

• "Barcode Zone Configuration"

Each application uses a different predefined default tray configuration file (*.735):

Application Easy: default_Easy.735
Application 1MM: default_1mm.735
Application SPETT: default_SPETT.735
Application Profiler: default_Profiler.735
Application SampleTrack: default_SampleTrack.735

The current default path can be checked in the Gilson Liquid Handler 215 configu-
ration.

The solvent and reagent information and the tray file name can be saved in the
*.cfg file (path written in the tool tip on the configuration name) and the tray infor-
mation in the tray file *.735 when the Apply and OK buttons are pressed.

Tray File Configuration 4.5.1

For applications with SampleTrack (Profiler, SampleTrack):

• Modification of racks and zones in the tray area are not allowed.

• All rack insert and remove operations are done automatically with the barcode
reader.
44 (99) BRUKER BIOSPIN User Guide Version 004



Working Area Configuration
For applications without SampleTrack (Easy, SPETT):

Figure 4.6. The Tray Configuration dialog box for Applications without Sample-
Track

Press the Apply or OK button to save the tray configuration to the *.735 file.

Adding Rack Tubes to a Zone
Only tubes assigned to a zone can be used in other configuration dialog boxes or
in procedure steps.

1. Insert rack with a zone and tubes for one rack.

• A very fast way to define a tube when inserting a new rack manually.

• A new zone is defined after inserting the rack and all tubes of the rack will be
added to the zone.

• See "Insert Racks with Barcode Simulation" on page 88.

2. Inserting rack tubes with a zone for more than one rack or for a part of one
rack.

• The very flexible tube definition will be performed manually in three steps:
- Insert a rack into a carrier (shown as a dark gray area, other names „contain-
er“ or „site“.
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- Add a new zone (see "Adding Zones and Tubes to a Zone" on page 90).
- Add tubes to a zone (see "Adding Zones and Tubes to a Zone" on page
90).

3. Insert racks with a zone and tube using the barcode reader.

• When a barcode reader is installed, tube definition will be done automatically
when reading the barcodes of barcode defined racks (see "Barcode Zone
Configuration" on page 48).

New customer racks could be created and modified using the context menu Rack
Editor of the tray control (see "The Rack Editor" on page 57).

Remove Racks from the Tray 4.5.2

• Open the Tray Configuration in the Configuration View.

• Double-click on the gray rack area (not on a tube) or use the context menu
„Remove selected rack“.

• Confirm the delete operation in the popup message with „Yes“.
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Working Area Configuration
Solvents in Tray Configuration 4.5.3

Solvent can be defined at all positions in the tray configuration. The position must
be a member of a zone (see "Adding Zones and Tubes to a Zone" on page
90).

Figure 4.7. The Solvent Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the
"Solvent Names Configuration".

Reagent in Tray Configuration 4.5.4

Reagents can be defined at all positions in the tray configuration. The position
must be a member of a zone (see "Adding Zones and Tubes to a Zone" on
page 90).
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Configuration
Figure 4.8. The Reagent Configuration dialog box 

Reagents can be used in TASK procedures with the type “ADD”.

Barcode Zone Configuration 4.5.5

The barcode configuration dialog box can only be used if a barcode reader is in-
stalled.

Containers (carriers for racks) can be defined as “barcode defined racks”, where-
as an automatic barcode reading can be performed here when starting the prepa-
ration program.

Defining Barcode Defined Racks
• “Double click” on the rack area, or on a dark gray container area, to define it as

a “barcode defined rack” (or to undo this definition).
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Working Area Configuration
Figure 4.9. The Barcode Zones Configuration dialog box 

Checking Barcode Rack Information
Open the Tray View and select the “Barcode” view mode to see all “barcode de-
fined racks”:

• A red frame will be displayed if the rack is a “barcode defined rack” 

• See Tool tips for details on rack information

When starting the preparation with “Autostart”, two barcodes from each “barcode
defined rack” are read automatically: 

• If a valid Type Barcode and Barcode ID are read when executing the pro-
gram, any older rack will automatically be removed and the new rack inserted.

See also: "Insert Racks with Barcode Simulation" on page 88.
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Configuration
Figure 4.10. Example of a Gilson Tray Configuration 

(The example shows a tray configuration file (*.735) with only two “barcode de-
fined racks”)

Ports in Tray Configuration 4.5.6

This configuration dialog box is for use only with applications used with Sample-
Track (Profiler, SampleTrack)!

Ports with predefined names can be defined in predefined zones (one position
only) in the tray configuration. Automatically defined ports include Injection and
InjectionMS.

The Switch NMR and MS Port button can be used to switch the right/left position
of the valves 819 in the tray.
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Z-Tower Configuration
Figure 4.11. Example of a Ports in Tray Configuration

Z-Tower Configuration 4.6

The Z-Tower configuration dialog box allows the following settings to be changed:

• The Z-Tower size can be defined to 125 mm or 175 mm.

• The Z-Tower calibration clamp height can be defined (use the value written on
the adjustment tube!).

• The barcode reader mounting position can be defined (old position: X = -49).
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Configuration
Figure 4.12. The Z-Tower Configuration dialog box 

Note: Liquid level sensing is not used!

Solvent Names Configuration 4.7

The Solvent Names Configuration dialog box is used to define the names of the
solvents used in experiments.
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ValveMate Configuration
Figure 4.13. The Edit Solvent Names Dialog Box

To insert a solvent name select the name from the NMR Solvent list or enter a tray
or dilutor solvent. Press Add to add the solvent to the list.

ValveMate Configuration 4.8

In the ValveMate configuration dialog box, solvents can be assigned to the Valve-
Mate positions.
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Configuration
Figure 4.14. The ValveMate Configuration dialog box 

The Solvents Configuration button can be used to define solvent names in the
"Solvent Names Configuration" dialog box.

The Edit Automatic Wash Procedures button can be used to define wash pro-
cedures in the "Execution Mode Configuration".

Valves & Capillary Configuration 4.9

In the Valves & Capilllary Configuration dialog box:

• Properties of “Gilson 819” valves can be defined: name, GSIOC ID, default po-
sition.

• Properties of additional Bruker valves can be defined: name, Gilson output
connector, default position.
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Gilson Cover & LED Configuration
Figure 4.15. The Valves & Capillary Configuration Dialog Box

Gilson Cover & LED Configuration 4.10

The Gilson Cover & LED Configuration dialog box is used to define the reaction
after the cover is opened. Specifically:

• The input port of the “cover open switch”.

• The output ports of the Gilson status LED’s.

• The reaction when opening the cover (stop and wait until closed).

• The reaction when closing the cover (reading all barcodes again). 

Figure 4.16. The Cover Configuration Window 
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5The Rack Editor 5 

Opening the Rack Editor 5.1

To open the Rack Editor select „Rack Editor“ from the Tray Control in the Tray
Configuration dialog box. 

The file “CustomRacks.geo” is used for customer defined racks. By a new instal-
lation it is not overwritten if it already exists. If it does not exist, it will be created as
a copy of the empty rack file “CustomRacksEmpty.geo” (delivered with the setup
file).

Warning shown when the file “CustomRacks.geo” does not exist when opening
the Tray Configuration dialog box: 

Warning shown when the file “CustomRacks.geo” can not be created: 

Error shown if both custom rack files do not exist when opening the „Rack Editor“
dialog box: 
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The Rack Editor
Rack Editor without a carrier (other names: container or site) selected: 

See also: 

1. "Rack Selection" 

2. "Creating a New Rack" 

3. "Bruker or Custom Racks" 

4. "Modifying Racks" 

Rack Selection 5.2

When you click on a rack (that is placed in a carrier) it will show a light blue frame
around the selected carrier, and the rack information will be displayed in the Rack
Editor. 

Figure 5.1. Rack Editor with Rack Selected 
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Rack Selection
Old Gilson defined racks do not have values for rows or columns. Only tube val-
ues in the tube list can be displayed!

Carrier Selection 5.2.1

When you click on a dark gray carrier area, it will show a light blue frame around
the selected carrier and the Select rack button will be enabled: 

Figure 5.2. Selecting a Carrier

Using the Select rack button, a rack can be selected from a list of all racks that
can be used for the selected carrier.

Figure 5.3. Selecting a Rack 
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The Rack Editor
“[Bruk]” racks in the selection list are delivered from Bruker with the installation
and cannot be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be mod-
ified. 

Creating a New Rack 5.3

After opening the Rack Editor the button “Create new Rack” is disabled: 

Existing rack values can be used by clicking on an existing rack in the tray view!
Use existing rack values to add the new rack to the carrier list of an existing rack!

After manually changing the “Rack Name” edit field to a new rack name (not an
existing Bruker rack name or custom rack name!) the button “Create new Rack”
will be enabled. 

Define the total size of the new rack in the fields “Dimensions x” and “…y” (the
values of an existing rack can be used by clicking on the rack in the tray view be-
fore changing the name).

Define the Carrier (list), where the new rack can be placed by clicking on an exist-
ing rack in the tray view (otherwise the new rack can only be displayed in the cur-
rent selected carrier after typing the rack name manually)

List with no carriers defined (left) - List with carriers defined (right):
60 (99) BRUKER BIOSPIN User Guide Version 004



Creating a New Rack
The Create New Rack button will create the new rack as a “Custom” rack: 

When the button is pressed and a carrier is defined for the new rack, the new rack
will be added to the bottom of the selection list:

“[Bruk]” racks in the selection list are delivered from Bruker with the installation
and cannot be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be mod-
ified. 

Deleting a Rack 5.3.1

A custom rack can be deleted using the Delete Rack button. Bruker racks cannot
be deleted.
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The Rack Editor
Bruker or Custom Racks 5.4

Racks can be defined as Bruker racks or Custom racks.

Bruker Racks: 
• Bruker is shown in the upper left corner of the Rack Editor: 

• Rack data is delivered from Bruker with the installation and cannot be modified

• Rack data is defined only in the file “default.geo” 

• Racks are displayed in the selection list with the prefix: “[Bruk]” 

Custom Racks:
• Custom is shown in the upper left corner of the Rack Editor:

• Rack data is defined by the customer and can be modified and deleted.

• Rack data is defined in the file “default.geo” and in the file “CustomRacks.geo”.

• Racks are displayed in the selection list with the prefix: “[Cust]”. 

Modifying Racks 5.5

First select an existing rack in the Rack Editor (see "Rack Selection" on page
58). 

Note: Only custom racks can be modified!

The Rack Editor can be used to define a Tube Matrix in a rack.

Old Gilson defined racks do not have values for rows or columns. Only tube val-
ues in the tube list can be displayed!

The total rack size can be defined in the edit fields “Dimension X” and “Dimension
Y”: 

The position of the top left tube of the matrix can be defined relative to the center
of the rack or relative to the top left corner of the rack. 

The values of the opposite mode are calculated automatically using the total rack
size in the fields “Dimension X” and “Dimension Y”. 
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Modifying Racks
The number of rows and columns can be defined in the edit fields “Rows” and
“Columns”.

The space between two rows can be defined in the edit field “Spacing (Y)”.

The space between two columns can be defined in the edit field “Spacing (X)”.

An additional offset of even rows/columns can be defined in the edit fields “X Off-
set of even rows” and “Y Offset of even columns”. 

The Create New Matrix Tubes button will create all matrix tubes and display
them in the tube list: 

The Define size of all tubes button is used to open the “Set Tube Size” dialog
box where the matrix tube size can be defined: 

The mode Labels on Rows / Columns: „A1“...“H12“should be only selected if
there is no offset defined for even rows or columns!
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The Rack Editor
Pressing the Apply button saves the modified rack data in the files “default.geo”
and “CustomRacks.geo” files and displays the data in the selected carrier high-
lighted with the light blue frame: 

The yellow pop-up window displays all the tube values for easy verification!

Service Tools 5.6

The Service Tools are for trained Bruker Service Personnel Only!
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6Preparation Data 
Files 6 

Data Directory Structures 6.1

Structure:

[Install Folder Data]\G215Data\

\Config\

\Config\Restore\

\Proc\

\Easy\

\1mm\

\SPETT\

\Profiler\

\SampleTrack\

\Test\ for release test files 

\ProcTest\

\Easy\

\Profiler\

\Exec\

\Exec\Restore\

Obsolete folders:

\Custom\

\BEST\

Main Folder 6.1.1

[Install Folder Data]\G215Data\ (defined when installing the program)

Configuration Files Directory 6.1.2

[Install Folder Data]\G215Data\Config\
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Preparation Data Files
1. All data in the current configuration (file extension: *.cfg), including the tray file
name, e.g. Current_Config_data.cfg.

2. Data in the current tray (file extension: *.735), including the tray geometry da-
tabase file name, e.g.: Current_Tray_Config.735.

3. Data of tray geometry database (file extension: *.geo). This file is used when
inserting racks (e.g. after barcode reading). e.g.: GRack_data_all.geo.

Preparation Procedure Files Directory 6.1.3

[Install Folder Data]\G215Data\Prep\

Common procedure files used for initial control settings (file extension: *.gsp or
*.gfp).

Temporary Settings Files 6.1.4

[Install Folder Data]\G215Data\Exec\

1. Saved Session file after an error or Menu "Save Current Protocol (... log)
Files".

2. Current preparation status file (file extension: *.sts - currently not used).

[Install Folder Data]\G215Data\Exec\Restore\

All default setting files (file extension: *.pgi) to restore to installation values.

Temporary Protocol Files 6.1.5

[Install Folder Data]\G215Data\Exec\

1. Current main protocol file of the current session (log_exec.log).

2. Current protocol file of the running procedure (log_current.log).

3. Saved protocol files (saved_log_exec.log and saved_log_current.log) after an
error occurs or after saving the file with the menu "Save Current Protocol (...
log) Files".

After completion of the SampleTrack order procedure the current protocol file, [In-
stall Folder Data]\G215Data\Exec\log_current.log, will be renamed (to the or-
der name) and saved in the SampleTrack order files directory:

[Order Folder]\bstsdata\gilson\out...\protocol\ 

See also: "View Current Protocol File" on page 31) and the "Directory Struc-
ture of Order Files" on page 69.
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Viewing Preparation Procedure Data Files
Viewing Preparation Procedure Data Files 6.2

Press the Step View button in the Toolbar to display the currently loaded/running
master step procedure.

The menu selection Compare Procedures can be used to check/compare any
procedure. All steps are displayed in a text file similar to the current protocol file.

To find the file directory see the "Data Directory Structures" on page 65.

Protocol Files 6.3

Current Preparation Protocol File Directory: (see also: "View Current Proto-
col File" on page 31).

[Install Folder Data]\G215Data\Exec\

Two protocol files are written automatically:

1. Current main procedure protocol file: log_exec.log

2. Current protocol file of running procedure: log_current.log

After an error or when selecting menu option "Save Current Protocol (... log)
Files" a copy of the current protocol files will be performed:

log_current.log to ...\G215Data\Exec\saved_log_current.log

log_exec.log to ...\G215Data\Exec\saved_log_exec.log

After completion of the order procedure the current protocol file, [Install Folder
Data]\G215Data\Exec\log_current.log, will be renamed (to the order name) and
saved in the order files directory: 

C:\bstsdata\gilson\out...\protocol\ 
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Preparation Data Files
(See the "Data Directory Structures" on page 65)

Directory of saved protocol files after execution of orders: 

[Order Folder]\bstsdata\gilson\out\protocol\ - (when running with SampleTrack)

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\ - (when running without Sam-
pleTrack -

e.g. BAY000100 NMR 31.log

(See the "Directory Structure of Order Files" on page 69).
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7Order Files 7 

Directory Structure of Order Files 7.1

Note: To allow access to old order information, old files will not be automatically
deleted!

The user should delete all old orders in the subdirectories listed below by using:

The menu option „Service Tools“ + the button: 

Note: „order files“ in the JCAMP format will be used when working without Sam-
pleTrack

Note: „order files“ in the JCAMP format will be used when working with Sample-
Track using the old file system (1 mm applications)!

Note: „order files“ in the XML format will be used when working with SampleTrack
via a SOAP server (Profiler and SampleTrack applications)!

Directory Structure for Order Files:

[Order Folder]\bstsdata\gilson\

\in\

\in\exec\

\in\save\

\in\error\

\out\

\out\save\

\out\error\

\out\protocol\

\in_no_ST\

\out_no_ST\

Main Directory 7.1.1

[Order Folder]\bstsdata\gilson\ (defined by SampleTrack)
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Order Files
Input Order Files Directory 7.1.2

[Order Folder]\bstsdata\gilson\in\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\in_no_ST\ (when running without Sample-
Track).

Contains all order files (file extension: *.p) to carry out.

After pressing OK, the files will be moved into the directory \in...\exec\. 

After verifying an error the files will be moved into the directory \in...\error\.

After execution of the order, the files will be moved into the directory \in...\save\.

Output Order Files Directory 7.1.3

This results after execution.

[Order Folder]\bstsdata\gilson\out\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\out_no_ST\ (when running without Sample-
Track).

Contains all order files with results after execution (file extension:*.r).

After result handling by the SampleTrack Communicator, the files will be moved
into the directory \out\save\ if status OK, or into the directory \out\error\ if an er-
ror occurs. 

Order Protocol Files Directory 7.1.4

Results after running the order procedure. 

[Order Folder]\bstsdata\gilson\out\protocol\ (when running with SampleTrack).

[Order Folder]\bstsdata\gilson\out_no_ST\protocol\ (when running without
SampleTrack).

After completion of the SampleTrack Order procedure, the current protocol file [In-
stall Folder Data]\G215Data\Exec\log_current.log will be renamed (to the order
name) and saved in the SampleTrack order files directory: 

[Order Folder]\bstsdata\gilson\out...\protocol\ 

(See also "Data Directory Structures" on page 65).
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Viewing Order Files
Viewing Order Files 7.2

To see the JCAMP SampleTrack order files:

1. Right-click on the order in the order list and select Show input order file to
display the order information.

2. Right-click on the order in the order list and select Show output report file to
see the report information.

To see the protocol files: Double-click on the order in the order list!

To find the file directory refer to "Directory Structure of Order Files" on page
69.
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Order Files
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8Solvents 8 

Defining Solvents for Preparation 8.1

To edit the solvents names used for preparation, open the "Solvent Names Con-
figuration", whereas:

• All defined external NMR solvents can be used.

• Additional solvents can only be defined for the preparation.

To define the solvent positions in the Gilson tray area for preparation, open the
configuration dialog box (see "Solvents in Tray Configuration" on page 47)
and click on the place where you want to use the solvent:

To define the solvent positions at the Gilson ValveMate open the "ValveMate
Configuration".

Defining External NMR Solvents 8.2

The external NMR solvents are used inside the "Solvent Names Configura-
tion", which is a dialog box used to define the preparation solvents used.

For Profiler applications the external NMR solvents are delivered by the Web
Services server directly.

For other applications:

• The external NMR solvents are defined inside a text file (e.g. solvents.txt).

• The name of this text file can be defined in the configuration dialog box (see
"Default Files Configuration" on page 40) or by clicking on the Gilson liquid
handler 215 (default files, ...) to open the configuration Gilson 215 dialog box.
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Solvents
Figure 8.1. External NMR Solvent Configuration 

In the property sheet Default Files, the default file name and directory of the type
External NMR solvent file can be changed to define the ambient solvent file used.

To view or edit the configuration see "Open Configuration View" on page 37.
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9Edit Procedures 9 

Modifying TASK Procedures 9.1

If the source TASK procedure is selected in the registry, then you must:

1. Modify the procedure in the menu “Service tools” -> "Modify Procedure" or us-
ing the Toolbar button. Select another TASK procedure if there is no correct
TASK procedure in the Registry entry.

2. Export the procedures and display them in the SampleTrack selection box us-
ing the menu “Service tools” -> "Initialize Pump"

TASK Procedures 9.2

TASK procedures are special procedures with a customer dialog box for each dif-
ferent type, used to easily change procedure parameters. 

Common TASK dialog box Elements 9.2.1

In the top of the dialog box the name of the procedure and the Custom (green) or
Bruker (red) type is shown:

 

(see "Bruker or Custom Racks" on page 62)

With the ’...’ button another TASK procedure of the same type can be loaded.

TASK procedures can be saved using the ’Save As’ button (for all procedures) or
using the ’Save’ button (for CUSTOM procedures only). Names of existing Bruker
procedures can not be used!

The ’Cancel’ button can be used to close the dialog box without saving modifica-
tions.
User Guide Version 004 BRUKER BIOSPIN 75 (99)



Edit Procedures
Types of TASK Procedures 9.3

1. Common TASK procedures: 

"Task Procedure Wash"

"Task Procedure Clean"

"Task Procedure Add"

"Task Procedure Dispense"

"Task Procedure Mix"

2. Application specific TASK procedures: 

"Task Procedure 1MM Samples"

Task Procedure Wash 9.3.1

Wash tasks are only used to perform an automatic wash procedure for a different
ValveMate solvent if this option is selected in the execution mode configuration
(see "Execution Mode Configuration" on page 41).

Figure 9.1. Editor Dialog Box of a Wash TASK 

Optionally an intermediate solvent can be used.

If the Wash TASK will be used as the default wash procedure in the configuration,
the following check box must be selected: 
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Types of TASK Procedures
The default wash procedure can be selected in the configuration dialog box: 

Task Procedure Clean 9.3.2

Clean tasks can be defined as sub-procedures in each line of an Add Task!

Figure 9.2. The Modify Task Procedure Clean dialog box 

Clean tasks can be started using the menu without adding a task.

To edit or to run clean procedures: see "Clean Procedures Menu Commands"
on page 25.

Automatic Cleaning 
The clean procedure name is defined in the default files configuration (see "Clean
Procedures Menu Commands" on page 25).

Select the appropriate options in the Settings dialog box (see "Edit Settings
Menu" on page 14) to run this procedure. Automatic cleaning can be performed
before the beginning of the order procedure loop, and/or after the last order. 

This feature works only when starting with AutoStart button (shown at left)! 
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Edit Procedures
Task Procedure Add 9.3.3

An Add task is a flexible procedure that is designed to be modified by the user. All
lines in the Add Task procedure list are executed from the top of the list to the bot-
tom.

In the Add Task the user can modify a selected line (after selecting a line by click-
ing in the left column of the list) or add additional lines or delete lines.

In each line of an Add Task other tasks of the type can be defined and modified
with the Edit button: 

• Task Dispense

• Task Mix

• Task Clean 

At execution time they will be performed after the execution of the line. In each
line of an Add Task modifications must be updated in the list with the button!

The procedure list will be saved with the buttons Save As or Save. 

Figure 9.3. Modify Task Procedure ADD
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Types of TASK Procedures
Task Procedure Dispense 9.3.4

Dispense tasks can be defined as sub-procedures in each line of an Add Task.

Figure 9.4. Modify Task Procedure Dispense
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Edit Procedures
Task Procedure Mix 9.3.5

Mix tasks can be defined as sub-procedures in each line of an Add Task, but only
after a Dispense Task in the list.

Figure 9.5. Modify Task Procedure Mix

Task Procedure 1MM Samples 9.3.6

Note: It is recommended that you use the "Task Procedure Add" in most circum-
stances!
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Modifying the Procedure Dialog Box
Figure 9.6. Modifiy 1mm Samples Task

Modifying the Procedure Dialog Box 9.4

This dialog box is called from the Modify Procedure option in the View menu (see
"View Menu Commands" on page 27). When selected this option shows or
hides a Procedure View in the main window, which is used to modify Task proce-
dures at a high edit level for customers.

The last selected TASK procedure is written in the registry (entry: ProcedureLast-
Task) 

Modification: 

• “Custom” procedures have a green „Custom“ identification at the top of the di-
alog box and can be modified:

• “Bruker” procedures are delivered from Bruker with the installation, have a red
„Bruker“ identification and can NOT be modified. 
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Edit Procedures
With the button on the right, which is found on the right side of the cur-
rent procedure, another TASK procedure of the same type can be se-
lected: 

• If there was a TASK procedure of a different type selected the following mes-
sage box appears: 

All procedures can be saved as a file with another name with the button:

But only „Custom“- procedures can be saved in the current file with the button:

For „Bruker“  procedures the following button is not active:

If the current procedure in the Registry is not a TASK procedure the following
message box appears: 
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10Test/Service Tips 10 

Service Information 10.1

1. Default Speed Z Axis

• Can be defined in the registry: 

Software > Bruker Biospin > Gilson Control > GExecCtrl > Z Speed

• Values 1...5 (default= 4)
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Test/Service Tips
84 (99) BRUKER BIOSPIN User Guide Version 004



AHow To... A

Introduction A.1

The following tasks are discussed in the appendix:

"Define Application Type"

"Create Orders"

"Modify Task Procedures"

"Insert Racks"

"Insert Racks with Barcode Simulation"

"Adding Zones and Tubes to a Zone"

"Define Sort Orders"

Define Application Type A.2

When starting the program the first time after installation the default procedure se-
lection dialog box appears, allowing you to define the type of procedure and con-
fig settings in the registry.

Types of applications: (5 different types of applications can be selected) 

• Easy Preparation (working only without SampleTrack)

• 1mm Sample Preparation

• SPE Tube Transfer (working only without SampleTrack)

• Profiler Preparation (working only without SampleTrack)

• SampleTrack Preparation (working only without SampleTrack)

After performing an initialization using menu “Service tools” -> Initialize Pump,
all procedures in the export directory (defined in the"Edit Settings Menu") will be
exported to enable a selection of these procedures in the Create Orders dialog
box (without SampleTrack) or in the selection box of SampleTrack.

Create Orders A.3

The Create Orders dialog box is used to create test order files if SampleTrack is
not selected in the Edit Setting dialog box (see "Edit Settings Menu" on page
14).
User Guide Version 004 BRUKER BIOSPIN 85 (99)



The Toolbar button shown to the left is used to open the Create Test Or-
der Files dialog box. If SampleTrack is selected in the Edit Settings dia-
log box, then the button will be shadowed and unavailable.

Figure A.1. Create Test Order Files 

Variants for different settings:

"Insert Racks with Barcode Simulation" 

Modify Task Procedures A.4

To modify a task procedure:

1. Open the modification dialog box with the menu “Service tools” -> Modify Pro-
cedure (see "Modifying the Procedure Dialog Box" on page 81) or Toolbar
button.
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If the procedure export path is not correct, (e.g. another application was run-
ning) a message box will appear: 

In this case select another TASK procedure in the current application folder.

2. Export procedures with the menu “Service tools” -> Initialize Pump (see "Ini-
tialize Pump" on page 20).

Exported procedures will be displayed it in the selection box of SampleTrack or
in the „Create Orders Dialog Box“ (without SampleTrack). 

Insert Racks A.5

For applications with SampleTrack (Profiler, SampleTrack):

• Modifcations of racks and zones in the ray area are not allowed!

• All rack insert and remove operations will be done automatically with the bar-
code reader!

In this step only the rack will be inserted. A zone will not be created and tubes will
not be added to a zone! Use this method to define a zone for more than one rack
or for a part of one rack.

To insert racks with a new zone and to add rack tubes to a zone see "Insert
Racks with Barcode Simulation" on page 88.

Inserting a New Rack A.5.1

Open the tray configuration in the configuration view. 

With the mouse right-click on an empty (gray) container area (= site), which will
open the following context menu:

Select „Insert rack at selected site“.
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This will open the Select Rack dialog box where you can select a rack (you can
also double-click on “Create Order Dialog” with your mouse):

“[Bruk]” racks in the selection list are delivered from Bruker with the installation
and cannot be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be
modified. 

All tubes from the inserted rack are not assigned to a zone (with the color „white“).
Only tubes assigned to a zone can be used in other configuration dialog boxes or
in procedure steps.

Insert Racks with Barcode Simulation A.6

Barcode racks could be simulated manually without a barcode reader when defin-
ing the barcodes in a special input dialog box:

There are two ways to open the Tray Configuration:

1. Using the Configuration View

Open the Tray Configuration in the Configuration View.

2. Using the edit mode in the “Create Order” dialog box.

Use this only if no barcode reader is installed (defined in the base configura-
tion): 

Selecting the checkbox “Edit Mode” will change the mode of the tray control: 
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Tray Configuration: 

Step 1: Insert a barcode rack

With the mouse double-click on an empty (dark gray) container area or right-click
on an empty (gray) container area, and select „Insert Barcode Simulation Data“
from the context menu.

In either case this will open the Select Rack dialog box where you can select a
rack:

“[Bruk]” racks in the selection list are delivered from Bruker with the installation
and cannot be modified. 

“[Cust]” racks in the selection list (at the end) are customer racks and can be
modified. 

Selection Error:

• The following selection error occurs when no barcode type label is defined for
the selected rack (e.g. „Code 202“): 

Please contact Bruker or use another rack type if this error occurs!
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Step 2: Insert zone and add tubes to zone

After selecting the Rack Type, the tube numbering order and the rack ID must be
defined: 

To insert wellplates into a container rack, first insert the container rack (e.g. “205”
or “205MI”), then the wellplates (e.g. “WH12” or “WH12@1MM”).

The automatically assigned zone can be checked in the tool tip information of the
new tubes.

When using a barcode reader to detect barcode racks automatically, refer to
"Barcode Zone Configuration" on page 48 for information on the configuration!

Adding Zones and Tubes to a Zone A.7

Open the Tray Configuration in the Configuration View.

Note: Only tubes assigned to a zone can be used in other configuration dialog
boxes or in procedure steps.

When using "Insert Racks", all tubes are not assigned to a zone (displayed with
the color white).
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Adding a Zone Manually A.7.1

• Open the context menu Set Zone Properties from the tray control menu:

• In the Zone Maintenace dialog box select a zone from the zone list, or write a
new zone name in the edit field, and press the Add button.

• Modify the color of the zone pressing the Color button.

• Modify the numbering order of the tubes that will be added to the zone in the
section Starting Corner and Pattern.

• Press the OK button to temporarily save the new zone definitions in the tray
configuration diaglog.
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Adding Tubes to a Zone Manually A.7.2

• Select a defined zone in the Zone Maintenance dialog box list, or click on a
tube already assigned to this zone (the selected zone will be displayed in the
zone edit dialog box).

• Use a „Lasso“ mouse operation (the Lasso frame will have the color of the se-
lected zone) to add all tube in the lasso frame to the selected zone (only white-
colored tubes that are not yet assigned to a zone can be added to the selected
zone). 

Removing Tubes from a Zone Manually A.7.3

Tubes can not be removed individually from a zone, the whole rack with the tube
must be removed (see "Deleting a Rack" on page 61).

Adding Zones and Tubes Automatically A.7.4

A barcode reader must be installed for this procedure.

Two barcodes will be read on each rack automatically:

1. Type Barcode

2. ID Barcode

During this procedure:

• A new rack of the type Type Barcode will be automatically inserted.

• A new zone with the name ID Barcode will be automatically created.

• All tubes for the rack will be automatically assigned to the new zone with the
name „ID Barcode“ (see "Barcode Zone Configuration" on page 48).
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Define Sort Orders A.8

Only for applications without SampleTrack!

Sorting orders defines which order will be at the top of the order list and prepared
first. 

Select the sorting mode in the Edit Setting dialog box

All orders for all currently inserted racks can be sorted, or all orders inside one
rack can be executed together: 

Orders can be prepared according to there creation time (first created order will
be prepared first) - check by Time:

The sorting by Order name (Position) sorts the preparation in ascending order:

Sorting by Solvent sorts the preparation in ascending order (when ValveMate is
installed), but all orders with the currently connected solvent will be prepared first.
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